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    100% Free Hearts general help
Basic Rules - Hearts is a trick-based card game for 4 players.    The object of the game is to be the player with the 
fewest points.    Cards have the following point values: Hearts: 1 point, Queen of Spades: 13 points, Other cards: 0
points.

The game begins with all cards being delt. Next, select 3 cards from your hand to be passed.    After receiving 3 
cards passed to you, the player with the 2C will begin play.    Play continues in a clockwise manner. Each player 
plays one card and together they are called a trick.    The highest card in the led suit wins and the point value of all 
the cards in that trick are assessed.    You must follow suit until your hand is absent of the led suit.    At that point, 
any card can be played.    The player that wins the trick now leads a card.    Hearts cannot be led until they are 
BROKEN by either someone playing a Heart or the Queen of Spades on a trick.    Play continues in this manner 
until all cards are gone.

To brush up on these rules and basic strategy, please try our interactive Hearts 101 tutorial under the games Help 
menu.

Playing - To play your hand, click on the appropriate card in your hand that you wish to play when the arrow 
points to you.    It is also possible to play by entering the number corresponding to your card on the top row of 
keyboard (1-9,0, '-' for 11, and '=' for 12).

Difficulty - To quickly change the difficulty level in the game, choose Beginner for an easy game or Challenging 
for a more challenging game.    This level choice automatically sets the computer players and their attributes.    
Note that at the highest 'Master' level, the game will also enable a point handicap to make it extra-challenging for 
you.

Options - To change the game options for various Hearts variations (over 300 combinations possible!), select 
them under the options menu. General options have to do with customizing the game interface, game options 
change the Hearts variation and game rules, and scoring options change the scoring values used.

Players - To change the personalities of your computer opponents, select Player… under the Options menu.    You 
may wish to use the difficulty menu instead to automatically set players for you.

Tables and decks - To select a different table or deck pattern, select them under the Options menu.

Practice features - Various items under the Practice menu will allow you to take back a play, redeal, rebid, or 
replay a hand.    You can also assign specific cards to players or let the computer playout an obvious hand for you.  
You can also view a play history window or all player's cards if you want to analyze a hand in-depth.    It is 
possible to disable all of these options under game options.

Save/load/print - Finally, you may save, load, and print hands and play history under the File menu or via a 
button on the hand summary dialog.    This will allow you to print or save particularly interesting hands for 
possible replay later.    The current dealer, score, bags, and other game information is now also saved, allowing 
you to restore not just the hand, but the game itself as well.

Report a bug or bad play - The author has gone to great lengths to make the computer players in this game the 
most challenging available.    If you feel the computer made a poor play, use this option any time during that hand 
to save a detailed file that includes all the information we need to reproduce the hand, options, and players you 
chose.    You can then easily e-mail this text file to the author at support@freehearts.com to help make this game 
even better!



    100% Free Hearts tips and tricks

Here are my favorite advanced tips and tricks to enjoy the game more:
1. Quickly set the difficulty level of opponents using the Difficulty menu.
2. Adjust game speed and other cool stuff under the Options...General dialog.
3. Click in the bottom right corner to quickly show the last trick played.
4. Play the interactive tutorial to improve your game and learn the interface.
5. Use right-click menu to take back a play or get a hint.
6. Disable practice options & resist temptation under the General Options menu.
7. Partner or opponents frustrating? Throw a pie at them under Practice menu!

Keyboard shortcuts:
1. Use the keyboard number keys to quickly bid or play.
2. Use the spacebar to bid, swap, or play the 'hint'suggestion.
3. Use F1 in any dialog to bring up help and explain options for that dialog.
4. Use Shift-Ctrl-B (boss key) to quickly minimize game and turn off sound.



    Options: Picking your favorite game variation
100% Free Hearts offers extensive customization to support different game variations which affect both game play 
and scoring.    The options in 100% Free Hearts are broken up into three areas: 1) General options - to customize the 
game interface, 2) Game options - to change the variation of Hearts and game rules, 3) Scoring options - to change 
the values used for game scoring.

General options
Overall game speed - Slider sets how quickly the game play moves.    If you would prefer a faster game, try 
bumping this to the left a bit.    Note that at faster settings on slower systems, the game will not run as consistently 
smooth.    If you find the play too choppy and uneven, you might try a slightly slower speed setting.

Name prompt on start - Change this to Yes to enable the name prompt on game startup.    You can always change
your name at any time under Options menu and the previous name used will be restored automatically the next 
time you play.    This name is also used to track your statistics, separately for each name with comparison in the 
Statistics dialog.      With the registered Pro version, the player profile & settings are restored when selected.

Verbal Taunts/tabletalk - Change this to Disabled if you do not want to hear/see the occasional taunts that each 
player may say after each trick.    These taunts, just like real life, are only occasional, although more likely if 
someone shoots the moon.    Each taunt is unique to each character and situation in the game.    If you disable 
taunts under the sound options, they are shown visually in a little speech balloon.    Set to Chatty for a high 
frequency of taunts or Friendly or Serious for a quieter game.

Allow practice options - Change this to Never if you want all Practice options to be disabled (so you can avoid 
the temptation).    Change this to Always to use all Practice options (take back, hint, redeal, replay, and view 
history) without being prompted first.    The default Confirm allows all practice features after you confirm each 
time you use them.

Coach to suggest hints - Change this to the computer personality name that you wish to provide you hints for 
passing and playing.    If you are a more recreational player, you should probably choose a strong intermediate 
player like ProfPlum, as an expert player (Red, LadyLuck, and Sparky) may suggest passes and plays that may 
confuse you.    For more information, see Selecting a Computer Personality

View highest cards on - Change this if you wish to have the highest cards sorted on the right or left side of your 
hand.    This also changes the number sort order from low to high instead.
 
Popup card plays - This feature will raise a card in your hand when the mouse is passed over it.    'Play Ahead' 
allows you to select your upcoming card before it's your turn.    'If Valid' will pop up only cards that are legal play. 
Both (the default) enables both the 'Play Ahead' and 'If Valid' options.    And finally, 'Neither' will disable both 
types of popups.

Autoplay last card - Change this to In hand if you want the game to automatically play the last card in your hand.
Change this to In suit if you want the game to automatically play your only card in a suit if it is led.    Since you 
have no choice in what to play this can save you some clicking.

Show dealing of cards - Set this to None to disable the deal animation.    Set it to 2 (default) to 13 cards to show 
an animation of the cards being dealt.    Some feel this adds to game realism, others would rather skip it.    Choose 
your preference.

View point cards at end - Set this to Yes to view which player took which point cards (Hearts, QS, and JOD, if 
enabled) at the end of each hand.    If set to No it shows the cards as dealt at the beginning of the hand (before any 
passing).

Concede guaranteed - Set this to Tricks to concede tricks that are guaranteed winners by the current leader 
(Aces, etc).    Set this to Points to concede tricks if all the point cards have already been played (they don't affect 



the score).    Set this to Both to enable both options or Never to disable both.    This option is not available in the 
100% Free versions.

Game options
Passing Schemes - Choose in which order you want to pass cards or to have no passing at all.    L = Left; R = 
Right; A = Across; H = Hold (No passing in that round); S = Scatter (Scatter is when you pass one card to each of 
the other players).    The default is L,R,A,H.
 
Queen of Spades Breaks Hearts - If this is set to Yes when the Queen of Spades is played Hearts will be broken 
and thereby can be led on subsequent tricks.    This option is defaulted to Yes.

Need Jack of Diamonds to Shoot - If this option is set to Yes then the Jack of Diamonds must also be won in 
order to shoot the moon.      If you have this option set even if you take all the point cards, but have not taken the 
Jack of Diamonds, you will not have successfully shot the moon.    This option is defaulted to No.

Points on First Trick - This determines whether or not a point card (any of the Hearts or the Queen of Spades) 
can be played on the first trick.    This is defaulted to No.

Spot Ranking - Change this to Yes if you want to play using Spot Hearts scoring.    Each Heart is worth their face 
value (10H=10, AH=14), QS is worth 50 points, Shooting the Moon is worth 150, and if you play with the JD 
rule, the JD is worth -40. This option defaults to No.

Partnership Play - Change this to Yes if you want to play with a partner in playing Hearts.    Your partner will be 
the player across from you; your scores will be combined.    This is defaulted to No.

Who gets the first lead - This determines which person will start determined on which card they have.    Low 
Club means all players must play their lowest Club.    Dealer's left allows that player to lead any card.    This 
option defaults to the 2 of Clubs.

Hearts Must be Broken - Change this to No if you want to allow players to lead Hearts immediately.    Normally, 
Hearts must first be broken, meaning that someone was out of the led suit and trumped.    Some Bridge fans may 
like this option which will allow them to empty out all trump early in the hand.    This option is defaulted to Yes.

Show current hand points - Change this to No if you do not want to view the points taken immediately on the 
current hand in the scorecard.    For tournament practice and such, you may wish to turn this off and force yourself
to track who has taken what and when the points have been split.    This option defaults to Yes.

Scoring options

The following scoring values and bonuses can be (and usually are) set to negative numbers.    If they are, then that 
many points will be taken away when the bonus is achieved (since in Hearts the lowest score wins).    If you set 
the bonus to a positive number then that number of points is added to the score, making it more of a penalty.    For 
example: If you set the Taking No Tricks bonus to be -5, then taking no tricks would be a good thing.    Setting it 
to be 5 would then penalize someone for taking no tricks.
 
End game at- Set this to the game ending score.    Typically non-partner games are played to 100 points.    For 
partnership play you may want to play to 200 points or more.

Score handicap - Set this to this to a negative number to handicap yourself with the number of points indicated: 
you will start will that number of points, making it more difficult for you to win.    If you set the handicap to a 
positive number, that number will be added to your opponents scores making it easier for you to win.

Jack of Diamonds Bonus - Set this to the number of points you want taking the Jack of Diamonds to be worth.    
Most typically this is set to -10, this means that 10 points will be subtracted from the score of the player who takes



the Jack of Diamonds.

Moonshot Bonus - Set this to the amount that you want Shooting the Moon to be worth.    Someone shoots the 
moon when they take all the point cards (all the Hearts and the Queen of Spades).    Most typically Shooting the 
Moon is worth either 26 points: where all other players besides the one who has shot the moon has 26 points 
added to their score; or -26 points: the person who shot the moon has 26 points subtracted from their score.    Since
the game now prompts the player whether they want +26 or -26 after each moonshot, this setting is only used to 
determine how many points they are awarded.

Sunshot Bonus - Set this to the amount that you want Shooting the Sun to be worth.    Someone shoots the sun 
when they take all the tricks.    Most typically Shooting the Sun is worth either 52 points: where all other players 
besides the one who has shot the sun has 52 points added to their score; or -52 points: the person who shot the sun 
has 52 points subtracted from their score.    Since the game now prompts the player whether they want +52 or -52 
after each sunshot, this setting is only used to determine how many points they are awarded.

No Trick Bonus - Set this to the amount you want a player to receive if they take no tricks at all (regardless of if 
they have points in them or not).    When this bonus is used, it is typically set to -5.

Gate Bonus - Set this to the bonus a player receives upon exactly hitting each point gate (see next option).    This 
bonus is off by default (set to 0).

Gates Every - Set this to what point interval you want each gate at.    A player receives the gate bonus (see above) 
upon exactly hitting each point gate.    This is often set to 100 to give the losers a chance and some players like it 
every 25 points.    For example, if you set this setting to 25 and the gate bonus to -10 then if a player got exactly 50
points at the end of a hand, the game would take 10 points off their score.    The intention of the gate bonus is to 
encourage strategy by having players try to take an exact number of Hearts.    Gates at 100 points (with no bonus) 
are set as default.

QS (Black Lady) - Set this to the penalty for taking the QS.    This almost always set to 13 unless you are playing 
Spot hearts.



    Different computer play styles
One of the unique strengths of 100% Free Hearts is the variety of computer play styles you can play against.    Each 
computer personality passes and plays differently.    You may select which players you wish to play with under the 
Change Players option on the Options menu.    In this dialog you may also right-click on any players face to get 
details on that players play style.    You can also select to play with that player by clicking on the player.    The 
positions at the bottom of the dialog indicate which position each player will be in.    In particular, note that the 
North position will be your partner in Partnership Hearts so you might want this player to have a similar skill level 
and aggressiveness to yourself.    Specifically, each computer player has four attributes which affect their passing and
game play:

Skill - This central attribute assesses the players skill level in Hearts.    Beginners will usually play the most 
obvious play and may sometimes make mistakes.    Average players are recreational players that understand the 
game but do not use any advanced strategies.    Expert players will look at distribution and try to take into account 
what cards the other players may likely have or factor in the current game score in making their plays.    Note that 
expert players will use standard conventions, if applicable, (which for many partnership games may include 
finesses and signalling preferred suits to their partner).    This expert style of play may be confusing to recreational
players.

Memory - This attribute assesses the players skill at remembering what cards have been played so far.    Card-
counters will be able to take more chances guessing what the opponents cards are based on what they have played 
so far.    Expert card-counters will also remember better what suits their partner indicated a preference for (if 
playing partnership) and avoid leading suits that would help their opponents score points more consistently.

Predictability - This attribute assesses the players predictability.    Near-random players will catch other players 
off-guard with unexpected plays sometimes and their plays may vary (even with the same hand) from time to 
time.    Predictable players analyze their hands and consistently play the same given a particular situation.

Aggressiveness - This attribute assesses the players aggressiveness.    Aggressive players will generally Shoot the 
Moon more frequently and try to aggressively stop others from Shooting more often.

Difficulty - The difficulty level is calculated based on your opponent and partners attributes listed above.    Skill 
level is critical, but the other attributes can also affect the perceived difficulty level.    This level is displayed in both 
the titlebar and on the difficulty menu.    Setting the difficulty via the menu automatically selects players with 
attributes that would provide that level of difficulty.    If you want more control over the play styles of your 
opponents, use the player dialog instead.    Note that when you change the players manually, the difficulty level will 
be recalculated automatically.    You cannot have a Master-level game against a bunch of beginner players!

Customizing your own styles (Pro version only)
You may also customize any of the computer players by selecting details on the player and clicking the Edit button.   
You may then change the name, bitmap, and/or all of the player attributes for the given player.    This means you can 
rename the players to your friends names, change their styles so you have a host of expert players, or even include a 
custom bitmap for any of the players.    If you rename a player, it will offer to automatically copy over the taunts for 
you.    You can then re-record or replace these taunts with your own, if you wish.    If successful, you will see the 
picture change to your custom face and it will automatically be saved for future games.    For details, see 



Customizing images.  Changing the players attributes may adjust the corresponding calculated game difficulty level. 
Manually setting the difficulty level via the menu or resetting the game options will reset all the players attributes to 
game defaults.    Bitmap and sound files are never deleted on a reset.



    Customizing images and sounds
100% Free Hearts does not allow customization of the game images, sounds, or the use of themed skins.
This premium feature is only offered in Championship Hearts Pro.    You can customize all of the images and sounds
in the game.    You can even add your own photos and package them as a 'skin' to share with your friends or others 
on our free addons page at http://dq.com/addons.html    Upgrade to Pro today using the game's Upgrade menu and 
then customize Championship Hearts Pro to suit your personal style!



      Track and compare game statistics
100% Free Hearts does not provide statistics.
This premium feature is only offered in our Championship Pro version which tracks a number of statistics for an 
infinite number of players based on their name (although only the last 4 are visible at a time for comparison).    You 
can use different names/profiles to track different playing strategies, variations, or difficulty levels.    To change your
name, use 'Change name' option on the Options menu.    You can also enable 'Name prompt on startup'    from the 
General Options dialog if you share the game with others in your family or find yourself frequently changing 
players.



Hand and game scoring
Basic Scoring
 In most variations, default values are as follows: Each Heart won: 1 point, Queen of Spades: 13 points, all other 
cards: 0 points.    Shooting the Moon (taking all tricks) usually incurs a penalty on all the other players of 26 points.   
For point values of other variations, please see Picking your favorite game variation.If using the Spot Ranking 
option (under Game Options), each Heart card is worth their face value.    For example: 3 of Hearts = 3 points, Ten =
10, Ace = 14).    The QS is worth 50 points, Shooting the Moon is worth 150, and if you play with the JD rule, the JD
is worth -40.    Since the number of points per game is quite a bit higher, games are usually played to 400 points.

Above this, various bonuses can be awarded such as taking no tricks, Shooting the Sun (taking all tricks), or winning
a trick with the JD.    At the end of each hand, you only receive ONE bonus and/or penalty, whichever is greater.    
The scoring bonuses and penalties that are awarded are based on Picking your favorite game variation in the Game 
and Scoring Options dialogs.

In standard Hearts scoring, games are usually played until 100 points, or if playing Partnership, 200 points (you can 
set this under Scoring Options).      

 After all tricks are played, 100% Free Hearts calculates the score for the current hand and displays a brief 
description in the scoring summary dialog.    From this dialog you can save, print, or report the current hand as a 
misplay.    You can also replay the hand to try an alternative strategy.      



    Player Profile
Your player profile is your online control center.    This box contains various personal information that you have 
entered, as well as allowing you to choose your online game preferences.    This information will be displayed 
should anyone click on your online face.

Name or handle - Enter whatever name you would like to go by.    It can be real or ficticious so have fun!

Multiplayer rating (registered Pro version only) - A rating that is determined by how many games you have won 
and lost online and against whom you've played (read more about ratings below).

Playing from - Enter a real or ficticious location like Cardsville, USA or Denver, CO.

Multiplayer face - You may select any one of the robot player faces from the dropdown list or, if you have a 
registered Pro version, you can CREATE YOUR OWN custom face image to be used for your online personality for 
other players to see!    To create your own custom face image, follow these steps:

1) Select two photos or other computerized images to use (one will be for your Normal game face, the other your 
Happy face). Resize or crop them to 100x100 pixels using the Editing menu of your favorite photo editing software 
like MS Paintbrush, Photoshop, or Corel PrintHouse (check with the program's help file if you are unsure how to 
resize or crop a picture).
2) Save them to a location of your choice as BMP (uncompressed), GIF (no transparent color), or JPEG (not 
progressive) format. 256-color images seem to work best. File size MUST NOT exceed 10K.
3a) From within the game, select the Options menu and choose 'Change name/profile...'.    Click on the 'Multiplayer 
Face' dropdown list and choose 'Custom...'.    The game will then prompt you twice to select your custom face 
images. The first time will be for your Normal game face, the second will be for your Happy face. You should now 
see your custom face displayed along with your profile when you go online.    From now on, the game will 
automatically send this custom face to other players in your online games. 

Info - Here's your opportunity to tell a little about yourself.    You can enter your hobbies, your ICQ/AIM address, or
just a simple message like "I'm crazy about card games!".

The following are settings for hosting games online:

Online game type - Depending on if you want a just for fun game or a more serious competitive game, choose from
the following list:

·    Unrated: Just for fun
·    Rated: Improves your online Multiplayer Rating    (register Pro versions only)
·    Rated (Limit): Only players with ratings of either 200 below your's or higher than your's can join.
·    Tournament: For use during online tournaments
·    Ladder: A competitive game to be recorded at an online Ladder site.

Hearts game variation to play - Select your favorite game variation.    For details on what each variation is please 
see Picking your favorite game variation.

Password required to join - Defaults to None. Eliminate all but select players from joining your hosted game. Any 
player that wishes to join will need to know this password. 

Game description for lobby - A message that can entice or disuade certain players to or from joining your game.    
It can be a simple message such as 'Beginners Only'.

Time to play - This autoplay feature allows a host to select a time increment for a card to be played during the 
game.    This can be set to No Limit or from 5 to 60 seconds.    If a player does not play a card in the allotted time, 
the computer personality they have selected for hints will play for them.    The time limit for the bidding phase is 



double the autoplay value.

Voice Chat (registered Pro version only) - We provide full support for voice chat using a popular program called 
RogerWilco.    No more typing, just start talking! You can obtain this free-of-charge (300k download) from 
http://www.rogerwilco.com    If you host a game and have RogerWilco installed, it will automatically start hosting a 
voice chat session.    If you have slow-speed connection or don't want to host, simply close the RogerWilco window 
to end the session.    Once you have hosted with RogerWilco, the lobby will show a V in a circle by your game.    If 
others with RogerWilco installed join your game, it will automatically connect to your voice chat session when they 
join your game.

Allow watchers - This setting either allows or disallows people from watching any of the players in your game. 
Watchers can chat with all players, but only watch one player at a time.

 Multiplayer Rating (registered Pro version only)
 After playing a few games online, you will notice your Multiplayer Rating in your player profile changing 
(hopefully increasing!).    This number is determined using a standard formula developed by the USCF and is 
calculated by your win/loss ratio against the ratings of the players you have played against online.

Ratings are a way for competitive players to find others with similar skill levels or better.    Ratings are only 
calculated while you are playing online and you must be playing in a rated game, signified by an 'R' with a circle 
around it on the table listings.    You can host a rated game by selecting this from your player profile under 'Online 
Game Type'.

You start at 1400 with a special class rating of 'Newbie'. Being a 'Newbie' allows you some benefits! For your first 
ten online games, the results are doubled allowing you get a higher rating quickly. You can also improve your rating 
by playing the game 'bots online (if your rating is less than the bot's).    Each computer player has it's own rating that 
you can see when you click on their face while playing.    Be careful though, the 'bots can raise or lower your rating 
depending on who is doing the winning!

When you enter our lobby to play online, you will notice some players' names are in different colors.    This signifies
their ratings.    The darker the color, the higher their rating (and the more experienced the player).    This can help you
choose which players to play against.    

Ratings Chart - Rating points for standard partner play are calculated in the following manner (Standard 
Spades/Euchre/500 (which are partnership games) and Partnership Hearts):

* The average rating of the winning team is calculated. 
* The average rating of the losing team is calculated. 
* The losing team's average is subtracted from that of the winning team. 

Ratings points for standard Hearts, Gin, or cutthroat play in the other games are calculated in the following manner: 
* The average rating of all losing players is calculated by totaling their ratings and dividing by the number 

of losing players.
* This number and the winning player's rating are the numbers used to calculate the points gained or lost
 based on the chart below. 
* Each player's rating is adjusted accordingly. 

Scores are adjusted in accordance with the ratings chart, as shown below. 

Winners' rating | Winners' rating | Losers' rating
minus losers' rating | adjusted by: | adjusted by:
300+ points +4 points -4 points
200 points +8 points -8 points
100 points +12 points -12 points
0 points  +16 points -16 points



-100 points +20 points -20 points
-200 points +24 points -24 points
-300 points +28 points -28 points
                                                                                          



    Playing Multiplayer Games Online
There are two ways to enjoy the multi-player feature of 100% Free Hearts.    You can either play online via your 
Internet connection using the GameSpy lobby server or, if you have a registered version of 100% Free Hearts, you 
can also play a private game on your local area network (LAN).

How to Play Online via the Internet
To play online via your Internet connection, select 'Play ONLINE' from the game's Multiplayer menu.    The lobby 
window will open as you connect to the GameSpy lobby server.    Here you will see a listing of all the games 
currently being played in the Rec Room.    By default, you automatically host a game, which appears in the listings 
with your player name and three computer players or 'bots'.    At this point, you may wish to start your hosted game 
with computer players, wait until other players join your game, or join someone else's in-progress game.

Hosting a game
Behind the lobby window, your game window shows three other players and the message 'You are hosting a new 
game.    Click here to start or wait for others to join.'    Click in the center of the play field and the game's current 
variation summary will appear.    Click OK, cards will be dealt, and game play will begin, much like regular off-line 
play.    Outside players can still join your game even after you have started playing.

If your hosted game does not appear in the lobby window, reference the Frequently Asked Questions (FAQ) under 
the game's Help menu for DSL/cable/proxy information.

Joining a game
Upon connecting to the GameSpy lobby server, you will see a listing of hosted games, any of which you may join by
clicking on the 'JOIN' button.    If the game has already started, a message indicating that the game is in-progress will
appear and it will 'deal you in' once the current hand has completed.    At this point, play will resume.

Explanation of games in lobby
The lobby window lists all games curently being played. They are listed by game type (Hearts, Spades, or Euchre) 
shown by the icon in the lower left corner. Open positions are shown as JOIN. Player name colors indicate    player 
rating followed by a description of the game variation and a circle with a letter indicating the game type; U = 
unrated, T = tournament, R = rated game, L = ladder (see Player Profile for more details).    A P circle indicates that 
the game is being hosted by our proxy server.    This will happen if the host is behind a NAT or other firewall and is 
unable to host directly.    Proxy games will usually be slower, so its generally best if the player with the fastest direct 
Internet connection hosts.    A V circle indicates the game is hosted with RogerWilco voice chat and you will 
automatically be connected if you have RogerWilco installed.    A H circle indicates the game has 1 or more 
handheld clients running on a mobile device.    To the right, an icon also shows the game's current state: 4 arrows 
means its still forming (hasnt started yet), a # means the players are bidding (in games that have bidding), a few 
cards means they are passing cards (in games with passing), and card ? means they are in normal card play.    Finally,
a lock icon will also show if the host has password-protected the game.

Online Player Profiles
Your personal player profile allows you to select your preferences for online play.    You can edit your settings by 
clicking your online 'face' displayed on the left hand side of the lobby window, or choose 'Change name/profile' 
from the game's Options menu.    For more details on what each setting is, please read the Player Profile section.

To get details about online players, you can click on their player name from the table listings or from the players list 
located next to the chatcard and select 'Details' from the popup menu.    If you are already playing a game, you can 
click on their player face for their details. 

Watching a game
It is also possible to join a game to 'watch' without actually playing.    Simply click on 'Watch' from their player 
profile. You will be joined to the host's game and can watch and chat with the players in that game.    while you are 
in-game you can view only the player's cards that you are watching, not everyone elses. 



Exiting a game
To exit a hosted game, select 'Stop hosting game' from the Multiplayer menu or exit the program through the File 
menu.    To exit a joined game, you may choose 'Exit joined game' from the Multiplayer menu or click on the 'Leave 
Game' button from the lobby window.

To return to off-line play, highlight 'Play ONLINE' once again from the Multiplayer menu.    The lobby window will 
close and your game window will reflect the computer players you were previously playing with.

Lobby Rooms
By default, online play begins in the RecRoom.    This is where players of all levels can congregate for recreational 
play.    For registered Pro players only, the Aces Room is for competitive play and can be entered by selecting 
'Change Lobby Room' under the Multi player menu.    The other lobby room, TownSquare, is used for special events 
such as tournaments and the Aces room is for the most competitive registered players.

How to Play via LAN
If you have a registered Pro version of the game, you can either host or join a private game with a few of your 
friends by choosing 'Host LAN game' or 'Join LAN game' under the Multiplayer menu. 'LAN' could be your local 
home or office network or the Internet, if you are connected. Since LAN play uses your computer's IP address to 
host and join games and not the GameSpy lobby server, your private game will not be visible in the lobby window.    
To exit a hosted LAN game, select 'Stop hosting game' option under the Multiplayer menu.    To exit a joined LAN 
game, choose 'Exit joined game' from the Multiplayer menu.    This option is not available in the 100% Free version.

For information on playing LAN games with a direct cable connection, please read the Multiplayer section of the 
FAQ.

For questions regarding online play not answered here, or for problems with your hosted game not appearing in the 
list (using a proxy or firewall), please check our Frequently Asked Questions (FAQ) off the game's Help menu for 
more detailed tips.

Chatcards & Players List
Chat with all players in the lobby by clicking on the chatcard located in the lobby window or just start typing.    Send
your message by using the 'Enter' key or cancel it using the 'Esc' key.    Everyone in the lobby room can read your 
message and reply.    Use the arrows to scroll up or down to read previous messages.    During game play, use the 
game chatcard to talk to the other players sitting at your table only.

The Players List is on the right hand side of the lobby chatcard.    This displays what players are presently in the 
lobby.    You can then get player details or add them to a buddy list by clicking on their name and selecting from the 
popup menu.

Macros and Emotes (registered Pro version only)
Chat commands can enhance your online playing experience.    Emotes are fun and humorous statements that can 
help you express your glee or frustration during a game. There are also preset commands, or macros, to send 
messages to particular players, add players to a buddy list, or to silence the occassional badmouther. The following 
is a list of basic macros. For a complete list of emotes and for directions on how to add your own, just open the 
'macros.txt' file found in the 100% Free Hearts folder on your computer.

/buddy <name> - Command to add a person to your buddy list.    The buddy list is a list of people whose 
arrival/departure you want to be alerted to.    Example:/buddy John.    Use /buddy -<name> to remove a person.    
/mute or /supermute <name> You can use /mute command to silence a particular player's chat from your chatcard. 
The /supermute command (only usable by registered players with a rating of 1400+) will silence the player's chat 
from the entire lobby.
/lobby - Have the lobby chat echoed to your in-game chat card, or turn it off.    Use /l <text> to explicitly send a 
message to the lobby from the in-game chat card. 
/whisper <name with spaces>:<msg> or /w <name> <msg> - Send a message to someone that is only visible by 
you and the person you specify. Example:/w John How are you?. 
/reply <msg> or /r <msg> - Reply to a whispered message.    The reply will also be whispered. Example:/reply I'm 



fine. 
/shout - Have all your future in-game chats shouted to the entire lobby room.    Use the command again to toggle 
shouting off. 
/notify - Enable/disable lobby player arrival/exit notification. 
/alert - Enable/disable chat alert sound. 
/who - Shows all players connected to the lobby. 
/taunt [#/nil/pard/lost/won] - Have your profile character issue a taunt.    Example:/taunt nil. 
/me <action> or :<action> - Perform some action through chat.    Example: /me stands up and shouts.
 
Customizable Popup Menu
Should you click on any player name while in the lobby, a small popup menu will appear. A list of preset macros 
including 'details', 'mute', and 'buddy' are featured to allow you shortcuts to the most frequently used macros.    In the
registered Pro version, this menu can be customized to list your favorite predefined or user defined chat commands.  
To do so, open the 'macros.txt' file found in your game folder on your computer in Notepad and follow the 
directions.



    Benefits of Upgrading
This game is freeware with no purchase obligation whatsoever.      If you have enjoyed playing this game, please 
consider upgrading to the full Championship Pro version to get more features and help fund future game 
enhancements.    100% Free Hearts players are entitled to s special $22.99 price, and we believe you will find this 
game more challenging and enjoyable than any commercial card game out there.    Complete with a 10-day 
evaluation period AND a 60-day risk-free money-back guarantee, if you are not completely satisfied, you don't have 
to pay for it!

If you upgrade to the Championship Pro version, you get these additional benefits:
1. No popup upsell screens to slow down your play.
2. All player, game, and scoring settings are saved.
3. Higher-quality, hi-color player and game artwork.
4. MIDI background music and customizable sounds.
5. Full statistics on your playing ability.
6. Add-on gameroom themes or 'skins' for artwork.
7. Even more challenging opponents.
8. Chat and show all the cards!
9. Play rated games online!
10. Have your own custom face picture online.
11. Play and host custom game variations online.
12. Use time-saving emotes and create your own macros.
13. Use RogerWilco voice chat when playing online.
14. Many more tables and decks to play with.
15. Fully customizable computer opponents.
16. Create your own custom tables, card, and decks.
17. Improved player profiles with art choices.
18. Each profile can have its own variations.
19. Compare statistics between players/profiles.
20. Use advanced card assignment to program hands.
21. Premium support direct from the game author.
22. User-created themed skins such as The Simpsons.
23. Discuss advanced strategies direct with the author.
24. Improve your skills with the Mastering tutorial.
25. Assign and change cards in any hand.
26. Play history shows all plays of current hand.
27. Score history tracks each hand's score in the game.

Methods of immediate registration using a major credit card:
1. Connect to our secure Web site and order on-line with 128-bit encryption via the Order Now button at 
http://dq.com/order.html    If you have a browser and an Internet connection, this is the fastest, most secure, and 
easiest method of ordering.    You can also simply click on any of the Buy Now buttons inside the game.
2. Fax order (print Order form on the next page and fill it out) to 1-719-576-0123.
3. E-mail order form (fill out ORDER.TXT file) to orders@reg.net
4. Call 1-800-242-4775 with a major credit card.

Upgrading via check or money order or to get special $19.99 hardship price:
You can also send a check, money order, or postal order to register.    Print the Order form on the next page (or the 
order.txt file) and fill it out and enclose it with your check drawn on a U.S. bank.    Players outside the U.S. 
(including Canada), please obtain a postal order or international money order payable in U.S. funds.    Also, note that
the hardship price of $19.99 for students, military personnel, and senior citizens (with copy of ID) is only available 
with this option (check orders).    Finally, understand that U.S. postal mail has taken as long as 2 weeks to get your 
letter and check to me so be patient if you choose this option.    If you are in a hurry, you can register electronically 
(see above) or send it via Priority Mail.    We do e-mail out keys the day we receive your form and check (We trust 
that your check is good).



How long does it take:
We e-mail keys out within 1 business day (often within minutes!) upon receipt of your order.    For orders mailed in, 
allow 2 weeks for the slow Postal Service.    For disks to be shipped, allow    another week or so for delivery back to 
you.    For order status, please e-mail support@freehearts.com.

CDs:
If you prefer to have the program on CD, you can pay $9 more and I will ship you the current version on CD.    The 
Web site always has the latest and making the CD will result in a slow down of your order, so only order it if you 
REALLY need it.    You can also create diskettes of the game for your private use.    Instructions are included in the 
FAQ off of the Help menu.    Please allow 1-2 weeks for delivery of CDs.    International orders should expect 2-4 
weeks for delivery via Air Mail.

Once you receive your key:
Choose the Enter unlock key… menu item on the Register menu (or off the reminder    dialog if you are past the 
evaluation period).    Enter your name and key EXACTLY (including upper and lower-case) as they appear on your 
upgrade sheet.    The reminder screens will then be disabled and the upgrade dialog will show your name.    



    Contacting the author and Order form 

About the author: 
DreamQuest Software is a family-owned business based near the Colorado Rockies in the United States.    We 
depend on the honesty of card players like yourself to support quality games like 100% Free Hearts.    We thank you 
for your support!

 ORDER FORM FOR PRO CARD GAMES FROM DREAMQUEST SOFTWARE 5.24

Name: ___________________________________________________________ 

Day phone (in case of problem): _______________________________________

Street Address: ____________________________________________________ 

City, State, ZIP, Country: ____________________________________________

Email (PRINT carefully: _____________________________________________ 
(We never sell your private info, see www.dq.com/privacy.html)

Circle system: Win95    Win98    WinME    WinNT    Win2k    WinXP    MacOS9    MacOSX
OR mobile:      PalmOS    PocketPC    Nokia80    Nokia60    SonyP800    Other

CHOOSE GAME(S):    Hearts    Spades    Euchre    500    Cribbage    Rummy    Gin    Blackjack

____ Six-game bundle (save $75, choose 3, get 3 free!) $69.99
____ Three each for both Mobile and PC (save $75, pick 3) $69.99
____ 3-for-2 bundle (save $25, choose 3, only pay for 2!) $49.99
____ Single game registration (circle choice above) $24.99
____ Student, senior, military (circle above + copy ID) $19.99
____ Additional game or license (I already own _____) $19.99

____ Optional Game Software CD ($4 CD + $5 shipping) +$9.00
        (NOTE: CD contains all games, licenses sold seperately)

Mail your payment, this form, and copy of ID (for discount) to:
DreamQuest Software        Call 1-800-242-4775
542 W. Linden St. or fax to 1-719-623-0399 along with
Louisville, CO 80027 USA credit card # and exp date

Codes are emailed within 24 hours of receipt.    For postal mail, allow 2-3 weeks.

The best way to get support, tips, report a bug, or get the latest version of this game is via the Internet.    You can 
reach the 100% Free Hearts Web site at http://dq.com/ or send e-mail to support@freehearts.com.    We read our e-
mail every business day and usually reply within 24 hours.    You may also contact DreamQuest Software directly at 
303-665-0614.    For details on how to report bugs, see Known bugs and possible workarounds.



    Frequently asked Questions and Answers

Reporting bugs or getting support

 We have tried to answer many of your questions in advance in the Hearts Frequently Asked Questions and Answers 
(FAQ).    Almost 80% of our emails are answered in the FAQ and we have taken great effort to clearly provide 
answers, so please check here first.    Because of the many questions and answers contained therein, and in efforts to 
keep this document current, you may access the FAQ via our online support Web page at http://dq.com/faq.html.    
You may also read your product specific FAQ from under the game's Help menu.    

If you do not see an answer to your question in the FAQ, please contact the author for support.    Please, if the game 
crashes, or an expert computer plays poorly, please use the Report bug or bad play… option under the Help menu on
the hand that caused the error or bad play.    This will dump the player hands and play history out to C:\
BADHAND.TXT and bring it up in Notepad.    You can choose to save it under a different name if you wish, or 
simply cut and paste it directly into your email program.    You can then e-mail that file to the author, see Contacting 
the author, ALONG WITH A SHORT EXPLANATION and we will have almost all the information we need to 
recreate and then correct the problem in a future release.    With all the options, card deals, play orders, and player 
types, it is nearly impossible for me to clearly reproduce, analyze, and correct any misplay without this file.

Do not forget to include which player made the mistake, what the mistake was, and either the round # or the 
misplayed card.    Please report bugs even if you are not registered.    The game has come this far because of over 
1,000 reports and suggestions we have received from players like yourself.    If you do not have access to e-mail, you
can also mail postal letters to the address listed in Contacting the author.



    Version history
Due to the continued updates and the thousands of improvements to all of our games over the last year, we have 
moved the history out into a separate file, WhatsNew.txt.    This file can also be easily accessed from the games 
main Help menu. 




